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Chapter    :  PCS Improvements

PCS 2.5 Updates

Major Enhancements

PCS Bullhorn Web Integration
PCS 2.5 introduces features and enhancements to support seamless integration between PCS and 
Bullhorn Web data.

 

Bullhorn Web API

 Bullhorn Web API simplifies integration of Bullhorn Web data with PCS 2.5. By allowing the grouping of 
data from Bullhorn Web accounts into a single send to PCS, Bullhorn Web API eliminates the need to create 
Bullhorn Bridge configurations for each account . 

Bullhorn Bridge Mapping Import

PCS 2.5 includes a Bullhorn Bridge Mapping Import feature to streamline setup for customers using the 
Bullhorn Bridge to import Bullhorn inspections into PCS. Existing mapping is imported into the utility to 
expedite setup and ensure access to new PCSBullhorn WebIntegration functionality. 

Integration Issue Detection and Notifications

PCS version 2.5 and later includes Enhanced Issue Detection features that proactively identify a variety of 
integration issues for mapped facilities and trigger application and email notifications. 

Issue Detection Dashboard

The  Bullhorn Integration Dashboard provides a comprehensive list of detected integration issues for 
mapped facilities, including warning messages for facility-specific issues and access to the built in 
Integration Issue Resolution Wizard. 



PCS v2.5 Release History

2

Wireless Sync Support for Indirect Survey Data from PCS 
Survey Manager
PCS version 2.5 introduces support for wireless sync of Indirect Survey data from PCS Survey Manager. 

 

Enhanced Job Service Stability
PCS 2.5 includes enhanced PCS Job Service stability to resolve intermittent stops, bottlenecks, and 
interruptions in work flow. 

 

Improved Performance and Miscellaneous Updates
Various minor updates and fixes, including:

 l PCS Field Data Collector Branding Updates

 l Previous reading count defaulting to 1 for Field Computer send/receive

PCS 2.4 Updates

Major Enhancements

Enhanced Test Point Criteria

In response to evolving domestic regulations and expansion into international markets, PCS 2.4            includes 
enhanced flexibility in defining Test Point Criteria via the Criteria tab located in Options under the Tools 
menu. 



PCS v2.5 Release History

3

Figure     -1. Test Point Protection Criteria Custom Settings

Along with the hard-coded values available in previous versions, users are able to select Custom On, 
Custom IRF, or Custom mV Shift for Test Point Protection Criteria under the Information tab in the CPDM 
Data Grid.
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Figure     -2. Test Point Protection Criteria Options

Improved Performance and Miscellaneous Updates
The following updates were made in PCS 2.4 to improve performance and reliability. 

 l Resolved issue causing Shunt Factor fields to import incorrectly into PCS via the Basic Bridge. 

 l Fixed issue requiring Shunt Information fields to be selected when customizing prompts for data 
collection in Field Computer Send. The following fields are no longer visible when customizing 
prompts for data collection, but will be available and associated with the appropriate inspection fields 
on a field computer: 

 — AC Coupon Shunt Factor

 — AC Coupon Shunt Rating

 — AC Coupon Shunt Resistance

 — Coupon Shunt Factor



PCS v2.5 Release History

5

 — Coupon Shunt Rating

 — Coupon Shunt Resistance

 — Rectifier Current Adjusted

 l Updated the Survey Filter drop down menu in the data grid to display surveys organized by year.

 l Improved overall performance when using Picklists in filters across PCS functions including the data 
grid, reports, and graphs. 

PCS 2.3 Updates

Major Enhancements

Saved Hierarchy Selections

Specific hierarchy selections can be saved, allowing PCS users to quickly switch between different 
geographic regions. Saved hierarchies can be created, edited, and updated in the Select ROWs window. 
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Search User Hierarchy Definition

PCS Admin users can search for and access other users' saved hierarchy selections in the Select ROWs 
window.
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Enhanced Site List Prompt Theme Options

PCS 2.3              users have more flexibility in defining Site List prompt themes, allowing a mobile device to display 
custom fields instead of those hard-coded in previous versions of the software. 

NOTE: This enhancement only affects surveys sent directly to mobile devices running PCS Field Data 
Collector via the Send to Mobile, Send Mobile to Disk, or Send to Cloud options in PCS.
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Improved Logic for Derived Fields

PCS 2.3 includes improved logic for calculating Days Since First Bad Reading and Days Since Last Good 
Reading derived fields for facilities with no previous good inspections. The new logic ensures affected 
facilities are included in relevant PCS reports.

Refer to  System Field Descriptions and Work with Derived Fields for additional details. 

Improved Performance and Miscellaneous Updates
The following updates were made in PCS 2.3 to improve performance and reliability. 

 l Fixed multiple issues impacting picklist behaviors when values are deprecated or picklists are 
reverted, including:

 — Deprecated picklist options appearing in filter options.

 — Lack of prompt to maintain picklist definitions when reverting a picklist.

 — Inability to edit a picklist if the same value has been deprecated twice. 

 l Fixed prompt theme mismatch when users toggle between Selected ROWs and Route in Field 
Computer Send while there is a Prompt Theme defined for both filter criteria.

 l Resolved issue of inspection reports failing when there are images with missing links in the PCS 
image database. Reports are now generated with a missing image icon in place of images without 
links. 

 l Fixed issue of import from Allegro AX yielding permanent facility information in PCS when data was 
not collected during a survey.

 l Corrected issue of calculated (amps) fields being treated as NULL values in exception reports when 
used in filters. Amps values higher than a rectifier's rating now appear as expected in exception 
reports.

 l Resolved issue causing error when attempting to send to mobile without checking Warn When 
Outside Established Range Values Enabled option is not selected. 

 l Fixed issue causing  missing on/off date and time stamp when receiving data from Allegro AX and 
Mesa devices. 

 l Corrected issue causing low potential readings to be imported into PCS as 0.000 values. 

 l Resolved issue causing Rectifier Shunt fields with previously input data to be cleared after importing 

a .dat file. 

../../../../../Content/feat_field_desc/System_Field_Descriptions.htm
../../../../../Content/PCS_UserGuide/Working_with_Derived_Fields.htm
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PCS 2.2 Updates

Major Enhancements

Support for PCS Wireless Sync
PCS 2.2 introduces support for secure syncing of  facility survey data with devices running PCS Field Data 
Collector software over the air via American Innovations' proprietary cloud integration technology.

Updated and added features include:

 l Field Computer Send

 l Field Computer Receive

 l PCS Survey Manager Integration

For PCS Wireless Sync requirements and FAQs, refer to the PCS Wireless Sync data sheet.

Field Computer Send

The following updates have been made to the Options pane in the Field Computer Send window:

 l Added Send to Cloud option  for sending facility surveys wirelessly. Existing configurations and 
customizations can be used when sending survey data to the cloud.

https://www.aiworldwide.com/uploads/common/pcs-wireless-data-sheet.pdf
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 l Added Send Mobile to Disk  option for file-based transfers of facility survey data to Mesa 3 and Allegro 
AX field computers running the PCS Field Data Collector app. PCS Field Data Collector file formats 
can be exported directly without use of a transformation tool.

 l Changed name of the Send to Disk option to Send Allegro to Disk for file-based transfers of facility 
survey data to Allegro QX field computers.

Figure     -3. Field Computer Send Options

Field Computer Receive

The following updates have been made to the Data Source pane in the Field Computer Receive window:

 l Added Cloud option  for importing facility surveys wirelessly.

 l Added Mobile from Disk  option for file-based transfers of facility survey data from Mesa 3 and Allegro 
AX field computers running the PCS Field Data Collector app.

 l Changed name of From Disk option  to Allegro from Disk for file-based transfers of facility survey data 
from Allegro QX field computers.

Figure     -4. Field Computer Receive Data Window
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PCS Survey Manager Integration

PCS 2.2              supports entering a cloud integration token into the Options window for linking a PCS database to 
PCS [[[Undefined variable productsInfo_ai/cn/sm.softwareName]]].

Figure     -5. Integration Settings in Options Window

Improved Performance and Miscellaneous Updates
The following updates were made in PCS 2.2 to improve performance and reliability: 

 l Fixed issue keeping history file from being created when using Send Allegro to Disk option in Field 
Computer Send window. 

 l Fixed issue of inactive inspection fields appearing on field computer when Surveyed Status indicator 
is set to No.

 l Added warning if Output File Path is empty when sending facility survey data to disk. 

PCS 2.1 Updates

Major Enhancements

CartoPac Cathodic Protection Integration

PCS 2.1  includes integration with our next generation mobile software, PCS Field Data Collector. Through 
the Field Computer>Send window, you can now define that you want your survey to be packaged and sent 
to your mobile device running PCS Field Data Collector. All the configurations you've made to PCS 2.3 can 
be utilized with the new format, including routes, user defined fields, prompt themes, etc. The survey is 
transferred over a USB connection that leverages Android's Media Transfer Protocol (MTP).

If unable to upgrade to the latest version of PCS, the Survey Transformation Tool 
(transform.aiworldwide.com) can be used to translate surveys from legacy Allegro formats to be compatible 
with PCS Field Data Collector. This cloud-based tool must be used to convert both outbound and inbound 
surveys.

https://transform.aiworldwide.com/
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Figure     -6. Transformation Tool Website

KPI Dashboard

A dashboard was added to display key performance indicators (KPI) in a graphical format.

The dashboard can be access through the Reports/Graphs > Dashboard menu.

The dashboard includes the following KPIs:

 l Survey Completion — displays the percentage of facilities that have an inspection marked as 
Surveyed in the filtered date range in the current hierarchy selection.

 l Facilities by Type — displays the number of facilities broken down by Facility Type in the current 
hierarchy selection.

 l Maintenance Status — displays the current status of all maintenance items that fall into the filtered 
date range in the current hierarchy selection.

 l Test Point Exceptions — displays the number of exception for the most recent inspection records 
that violates the following criteria:

 — Structure Below Criteria: shows the number of inspections that are not meeting their defined 
Test Point Protection Criterion.

 — Shorted Casing: shows the number of inspections that have a Structure P/S-Casing P/S 
within the threshold defined in Options.

 — High AC P/S: shows the number of inspections that have and AC PS reading greater than 3.
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The dashboard only displays records from the current hierarchy selection. It can be further filtered by date 
range, facility type, or facility active status.

Selecting a KPI will display associated records  in the drilldown section at the bottom of the dashboard. The 
records can be further isolated by selecting individual components of the currently selected KPI. For 
convenience, a search bar is included to further filter your drilldown.

Refer to The KPI Dashboard in the PCS v2.5 User Guide for more information.

Bullhorn Web Integration

PCS 2.1 has been improved to provide greater support for integration with Bullhorn Web for AC and DC 
Current Density related data. 

PCS 2.1 now includes pre-configured system fields that are designed to store data gathered from 
RM4210s and RM4250s. For these fields, the Engineering Units have been configured in PCS 2.1 and 
Bullhorn Web to align by default, so now only the Facility IDs need to be updated in each system to import 
your data. 

The following fields have been added to PCS 2.1:  

Test Point Information 

 l AC Coupon Surface Area 

 l AC Coupon Shunt Factor  

 l AC Coupon Shunt Rating  

 l AC Coupon Shunt Resistance  

 l Coupon Surface Area  -Coupon Shunt Factor  

 l Coupon Shunt Rating  

 l Coupon Shunt Resistance  

Test Point Inspection 

 l AC Current Density  

 l AC Coupon Current 

 l AC Coupon Shunt Reading

 l Native AC P/S  -AC Drain Current  

 l Native Coupon P/S  

../../../../../Content/feat_reports_graphs/dashboard.htm
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 l Coupon P/S 

 l Coupon IRF  

 l AC Coupon P/S 

 l DC Current Density  

 l Coupon Current  

 l Coupon Shunt Reading

Field Updates

The following updates were made to fields in PCS 2.1:

 l Technician field was expanded from 20 to 50 characters.

 l New Survey Name  field was added that displays the name of the DAT/ZDVA from where the record 
originated.

 l Device Serial Number, DVM Serial Number, and DVM Calibration Date fields will now be stored 
outside the Survey Settings field so they can be used in grids, filters, and reports.

Improved Performance and Miscellaneous Updates

The following updates were made in PCS 2.1 to improve performance and reliability: 

 l Support for Allegro 7.2 (refer to Field Computer for more information about the field computer): 

 — Pipeline Current On and Pipeline Current Off are now paired for more accurate date capture 
when gathering interrupted amperage readings.

 — Timed readings now support Off readings and are paired with On readings.

 l Data Grid column headers now word wrap so you can fit more data in a single grid without scrolling. 

 l  Add Record window radio button description clarifies the record type and where the record is being 
added in Data Grid. 

../../../../../Content/feat_field_comp/Field_Computer.htm
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Figure     -7. PCS 2.0 vs PCS 2.1 - Add Record Window - Description of Record Type and Placement

 l Improved performance when manually adding new records through the Data Grid. 

 l Fixed an issue where new Bullhorn Bridge definitions didn't set the Start Date correctly. 

 l The Bullhorn Bridge now supports facilities with a Facility ID greater than 50 characters. 

 l Delinquency report now supports international date formats. 

 l The First Read and Second Read fields in the Delinquency report now show the date format your 
computer users, instead of YYYY-MM-DD. 

 l Duplicate maintenance records are no longer created when an update occurs on the Allegro to a 
maintenance item that has already been imported to PCS.

 l Facility IDs for non-rectifier facilities are no longer removed when Facility ID is not included in the 
bridge definition. 

 l Bulk actions (for example, Replace All) now update LastUpdateDateTime correctly.

 l New Facilities created on ROW Codes will properly inherit the Default Value from Default Location 
Format assigned in Field and UDF Customizations. 

 l Picklists now support inheriting the Default Value setting from Field and UDF Customizations. 



PCS v2.5 Release History

16

PCS 2.0 Updates

Major Enhancements

Linking Maintenance and Inspection Records

PCS 2.0 will now link inspection records with their related maintenance records when imported from a field 
computer, as well as linking maintenance records with their follow-up inspection records. This means you 
can find maintenance items related to a specific inspection record without manually matching Inspection 
dates with Repair Found dates. When a survey file contains both an inspection record and a maintenance 
record for the same site, those records are considered related and PCS will automatically link the inspection 
and maintenance records. If open maintenance records were sent to the field computer, the new 
inspection record created for the same site will be linked to the maintenance record.

A Linked Maintenance Count field is available in the Inspection grid for quick insight into which inspection 
records have linked maintenance records, a new Maintenance Links mini-grid has been added to the 
Inspection grid, and an Inspection Links mini-grid has been added to the Maintenance grid. 

Refreshed User Interface

PCS is the first American Innovations product to be refreshed and updated with our new, modern look. This 
design that all American Innovations products will adopt moves closer to a material design aesthetic, with 
updated icons and a new color scheme.
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Figure     -8. PCS's New User Interface

Sorting on Effective Date

Now with PCS 2.0, records in the Information, Inspection, and Maintenance grids can be sorted by 
Effective Date fields. With this update, you can update custom sort themes to sort based on the Effective 
Date to show either the oldest or newest records first.

Improved Performance and Miscellaneous Updates

Several updates were made in PCS 2.0 to improve performance and reliability, including: 

 l Bridge Reliability  – Several updates were made to improve the reliability of Bridge imports and 
exports. Bridge runs in PCS 2.0:
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 — more reliably rename or replace export files.

 — perform better validation processes to ensure Test Point Detail Information records with a 
blank PCS field are not imported and records with multiple pick-list selections chosen are 
exported consistently.

 — are no longer skipped on Sundays if scheduled to run multiple days a week.

 l Field and UDF Customization – Improvements were made to more elegantly handle changes to field 
properties in the Field and UDF grid.

 l Field Computer 

 l Themes

 l Grid Updates

 l Reports

 l Regional Settings

 l Special Characters

Changes to the PCS Databases

Tables That Have Been Added to the PCS Database

 l dbo.JobScheduleDefinition  

Tables That Have Been Removed from the PCS Database

 l dbo.EmailReportDefinitionAddition
 l dbo.EmailReportDefinitionOverride
 l dbo.SyncLogEntry

 l dbo.SyncPipelineSubscription
 l dbo.SyncSubscription
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Changes to Existing Tables in the PCS Database 

Synchronization Bit Removed — the following tables have had the synchronization bit removed:

 l dbo.ACCASurveyFolder
 l dbo.ACCIInspection
 l dbo.ACCISurveyFolder
 l dbo.ACVGSurveyFolder
 l dbo.ChangeLog

 l dbo.CISurveyFolder
 l dbo.DCVGSurveyFolder
 l dbo.InLineSurveyFolder
 l dbo.SoilResistivitySurveyFolder
 l dbo.ChangeLogChanges

Fields Added
The dbo.BridgeDefinition table had the following fields added:

 l ImportJobScheduleDefinitionId  l ExportJobScheduleDefinitionId

The dbo.CIInspection table had the following field(s) added:

 l ExportTimeInterval
 l ExportTimeOfDay

 l ImportTimeInterval
 l ImportTimeOfDay

The dbo.DCVGInspection table had the following field(s) added:

 l DCVGInspectionDateTime  

The dbo.DCVGSurveyFolder has the following field(s) added:

 l FieldComputerSurveySettingsId  

The dbo.EmailReport table has the following fields added:

 l JobScheduleDefinitionId
 l Hierarchy
 l Mode

 l Name
 l SendNoDataFound
 l NextRunDateTime

The dbo.FieldComputerSurveySettings table had the following field(s) added:

 l DcvgBeginPsOn
 l DcvgBeginPsOff
 l DcvgEndPsOn

 l IsNativeSurvey
 l FieldComputerSerialNumber
 l DvmSerialNumber

 l DcvgEndPsOff  l DvmCalibrationDateTime
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 l DcvgBeginHalfcellCalibration
 l DcvgEndHalfcellCalibration

 l RefCellCalibrationDateTime

The dbo.InLineInspection table had the following fields added:

 l ILInspectionAnomalyExtension
 l ILInspectionAnomalyTypeCL
 l ILInspectionAverageDepth
 l ILInspectionAxialOvality
 l ILInspectionB31GMAOP
 l ILInspectionBPRCalculated
 l ILInspectionBPRPig
 l ILInspectionBPRVariance
 l ILInspectionBurstPressure

 l ILInspectionInternalExternalCL
 l ILInspectionLengthAccuracy
 l ILInspectionMeasuredWallThickness
 l ILInspectionMiscIdentifier
 l ILInspectionMODB31GERF
 l ILInspectionMODB31GMOAP
 l ILInspectionOvality
 l ILInspectionRAWReferenceKey
 l ILInspectionRefEventIdentifier

 l ILInspectionCalibratedMeasure
 l ILInspectionCertaintyInterval
 l ILInspectionClusterIdentifier
 l ILInspectionComments
 l ILInspectionControlPointLF
 l ILInspectionCoordinateIdentifie

r
 l ILInspectionDataIdentifier
 l ILInspectionDepthAccuracy
 l ILInspectionDescription
 l ILInspectionDSAGMDistance
 l ILInspectionDSAGMReference
 l ILInspectionDSWeldDistance
 l ILInspectionDSWeldNumber
 l ILInspectionDSWeldOdometer
 l ILInspectionEventIdentifier
 l ILInspectionFeatureDescription
 l ILInspectionIdentifier
 l ILInspectionInspectionDate

 l ILInspectionRPRCalculated
 l ILInspectionRPRPig
 l ILInspectionRPRVariance
 l ILInspectionSeamOrientation
 l ILInspectionSMYS
 l ILInspectionStationReported
 l ILInspectionSurveyIdentifier
 l ILInspectionUSAGMDistance
 l ILInspectionUSAGMReference
 l ILInspectionUSWeldDistance
 l ILInspectionUSWeldNumber
 l ILInspectionUSWeldOdometer
 l ILInspectionWidth
 l ILInspectionWidthAccuracy
 l ILInspectionWithinSpecificationLF
 l InLineInspectionOriginalPoint
 l InLineInspectionOriginalPointAlph

a
 l InLineInspectionPlotThisPoint

The dbo.InLineSurveyFolder table had the following fields added:
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 l InLineInspectionIdentifier
 l InLineSamplingFrequency
 l InLineSurveyAvgTemp
 l InLineSurveyAvgVelocity

 l InLineSurveyRatedMaxVelocity
 l InLineSurveyRatedMaxWT
 l InLineSurveyResolution
 l InLineSurveySensorCL

 l InLineSurveyClusterRuleCL
 l InLineSurveyEndDate
 l InLineSurveyMaxTemp
 l InLineSurveyMaxVelocity
 l InLineSurveyMinTemp
 l InLineSurveyMinVelocity
 l InLineSurveyModel
 l InLineSurveyOdometerEnd
 l InLineSurveyOdometerStart
 l InLineSurveyPipeDiameter

 l InLineSurveySensorSpacingMax
 l InLineSurveySensorSpacingMin
 l InLineSurveySourceCL
 l InLineSurveyStartDate
 l InLineSurveyStatus
 l InLineSurveySurveyor
 l InLineSurveyToolType
 l InLineSurveyToolVendorCL
 l InLineVendorIdentifier

Fields Removed
The dbo.BridgeDefinition table had the following field removed:

 l CIInspectionDepthOfCover  

The dbo.EmailReport table has the following fields removed:

 l EmailReportDefinitionId  l OriginalReportId

The dbo.InLineSurveyFolder table had the following fields removed:

 l InspectionEndDateTime  l InspectionStartDateTime

The dbo.MetaParentAddition table had the following field  removed:

 l IsReplicated  

Fields Modified
The dbo.DCVGInspection table had the following fields' width changed:

 l IR from (5,2) to (5,3)

 l OTLtoRemoteEarth from (4,0) to (6,5)

 l SignalStrength from (5, 0) to (5, 4)

The dbo.FieldComputerSurveySettings table had the following fields' width changed:
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 l SecondsOff from (4, 3) to (5, 3)                   l SecondsOn from                   (4, 3) to (5, 3)

The dbo.Pipeline table had the following field's length modified:

 l PipelineEndPointAlpha from 15 to 50 nvarchar

Functions That Have Been Added to the PCS Database

 l dbo.MaxVal  l dbo.MinVal

New Stored Procedures in the PCS Database

 l dbo.recompile_prog  l dbo.RECREATE_TYPE

Stored Procedures that Have Been Removed from the PCS Database:

 l dbo.changeLogSynchronizationMaintenance

PCS 1.14 Updates

Major Enhancements

In-Line Inspection Data

In-line inspection data is now supported natively in PCS with a new In-Line Inspection (ILI) survey type 
added to the Internal Survey Manager (ISM) module. This survey type allows ILI data to be imported, 
reviewed, and analyzed in PCS. The Pearson survey type was also removed from the ISM module.

Custom Module Management and Custom Facilities

Modules installed with PCS can now take advantage of some of the features that custom modules enjoy. 
Custom facilities can now be created for installed modules, allowing companies to create facilities that are 
customized for their specific needs. To support the new custom facilities capabilities, Custom Module 
Management (CMM) was updated to display all modules and facilities set up in PCS. To learn more about 
CMM, email us at sales@aiworldwide.com or call 1-800-229-3404

PCS Viewer Integration

PCS 1.14 can now send historical data with survey records, supporting the new PCS Viewer Previous 
Readings feature. This improved integration between PCS and PCS Viewer allows users to easily view 
current and past data off-line without having to set up a subscription. To send historical data with a survey 

mailto:sales@aiworldwide.com?subject=Interested in Custom Module Management
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file, open Field Computer Send, select the Include Previous Readings check box, and define the Number of 
Previous Readings to send with the survey. To learn more about PCS Viewer, email us at 
sales@aiworldwide.com or call 1-800-229-3404.

User Experience

With PCS 1.14, accessing the data in a grid is more efficient now that users can define what data they want 
to see and how the data should appear before displaying data. A new setting in Options determines 
whether a PCS user will always be prompted to configure grid options before loading data or the grid 
options should only appear the first time a grid is loaded.

User-Defined Fields

New fields and functions were added to PCS 1.14 to support the increasingly complex calculation needs of 
compliance companies.  The Most Previous Inspection Date is a new System Field that helps companies 
comply with API 510 or 570. This field is the cornerstone for the calculations that determine the remaining 
life of an asset.

Calculated fields can now take advantage of expression-within-expression embedding, improved date and 
time functions, and a more robust MIN and MAX calculation. 

Bridge

Bridge was updated in PCS 1.14 to enhance the schedule options for data imports and exports. The 
frequency settings available when configuring a scheduled Bullhorn import, bridge import or export, or 
Bridge to External Database were aligned with the email notification schedule options.

Bullhorn Web Integration

Bullhorn Web integration has improved with an updated filter that identifies mismatched units and units that 
were not auto-mapped. Now when changes are made to fields in PCS or Bullhorn, newly invalid mappings 
can be easily identified and addressed.

[[[Undefined variable productsInfo_ai/cn/sm.softwareName]]] Integration

PCS 1.14 updates include increased support for [[[Undefined variable productsInfo_
ai/cn/sm.softwareName]]] files. Surveys, including those with images, taken from a field computer can be 
managed within [[[Undefined variable productsInfo_ai/cn/sm.softwareName]]] then packaged and sent to 
PCS. PCS can now receive DCVG data that has been imported into [[[Undefined variable productsInfo_
ai/cn/sm.softwareName]]] and then repackaged as a .zsvy file. To import [[[Undefined variable 
productsInfo_ai/cn/sm.softwareName]]] files, open Field Computer Receive, select to receive from disk, 
and navigate to the .zsvy or .zdva files.

mailto:sales@aiworldwide.com?subject=Interested in Survey Viewer
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Field Computer Send and Receive

When sending surveys by route, the facilities sent in the survey will no longer be limited to the facilities in the 
hierarchy selection. When selecting By Route in Field Computer Send, PCS will list all facilities in the 
selected route regardless of hierarchy selection.

A new option is available in Field Computer Send to allow maintenance repair codes that exist in PCS as a 
picklist to be pre-populated in the survey file. This prevents the Allegro user from having to manually 
populate the repair code field for each maintenance record. If your allegro prompt includes this type of field, 
select the Predefined Repair Codes check box in Field Computer Send.

When receiving surveys from an Allegro with software version 7.1, data about the field computer, such as 
DVM calibration dates and Allegro serial numbers, is now captured and stored in survey settings.

Summary Reports

Previously, Percent Surveyed data in Summary Reports would round to the nearest whole number. While 
visually pleasing, this did not provide enough precision for a user’s accurate analysis of the report data. With 
PCS 1.14, percent data now displays with one decimal point accuracy.

Concurrent Licenses in Citrix XenApp Environments

Customers who use concurrent licenses to access PCS previously struggled accessing PCS in a Citrix 
XenApp environment. PCS 1.14 improved the way concurrent licenses are handled to enable access within 
a Citrix XenApp environment.

PCS Help

Coming soon, a new American Innovations Support Site will integrate product documentation with an 
improved knowledge base of troubleshooting tips, recommendations, and specialized how-to articles. To 
accommodate the upcoming support site, the PCS online help has changed locations to: 
http://support.aiworldwide.com/AutoMerge/pc1/pc1.htm

Prior to using PCS 1.14, ensure all PCS users have access to the following domain: 
http://support.aiworldwide.com

Publication and Subscription Removal

The complicated publication/subscription model, also known as replication, has been replaced with the 
more user-friendly PCS Viewer application for offline data viewing. If you previously used publications and 
subscriptions to view data offline, synchronize and remove all subscriptions with PCS prior to updating to 
1.14. To learn more about PCS Viewer, email us at sales@aiworldwide.com or call 1-800-229-3404.

Improved Performance and Miscellaneous Updates

Several updates were made in PCS 1.14 to improve performance and reliability, including: 

http://support.aiworldwide.comautomerge/pc1/pc1.htm
http://support.aiworldwide.com/
mailto:sales@aiworldwide.com?subject=Interested in Survey Viewer
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 l Form Reports Functionality – Several updates were made to improve the functionality of Form 
Reports, including better support for formatting, styling, and exporting the form.

 l Custom Report Security – ensures user restriction for custom reports that are marked as private.

 l Increased Support of Calculated Fields in Filters – With 1.14, you can now filter records based on 
User Defined Fields that use first of month filters.

 l Date Format Support When Sending to the Allegro – Survey files created on a computer that uses 
date formats that are unavailable on an Allegro can still successfully send to an Allegro.

 l Sending the Entire Picklist Descriptions – Picklist descriptions are no longer truncated when sent to 
the Allegro.

 l Importing CI Surveys in GPS RT Mode – negative on or off values are no longer lost when using GPS 
RT mode.

Changes to the PCS Databases

Tables That Have Been Added to the PCS Database

 l dbo.JobScheduleDefinition  

Tables That Have Been Removed from the PCS Database

 l dbo.EmailReportDefinitionAddition
 l dbo.EmailReportDefinitionOverride
 l dbo.SyncLogEntry

 l dbo.SyncPipelineSubscription
 l dbo.SyncSubscription

Changes to Existing Tables in the PCS Database 

Synchronization Bit Removed — the following tables have had the synchronization bit removed:

 l dbo.ACCASurveyFolder
 l dbo.ACCIInspection
 l dbo.ACCISurveyFolder
 l dbo.ACVGSurveyFolder
 l dbo.ChangeLog

 l dbo.CISurveyFolder
 l dbo.DCVGSurveyFolder
 l dbo.InLineSurveyFolder
 l dbo.SoilResistivitySurveyFolder
 l dbo.ChangeLogChanges

Fields Added
The dbo.BridgeDefinition table had the following fields added:
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 l ImportJobScheduleDefinitionId  l ExportJobScheduleDefinitionId

The dbo.CIInspection table had the following field(s) added:

 l ExportTimeInterval
 l ExportTimeOfDay

 l ImportTimeInterval
 l ImportTimeOfDay

The dbo.DCVGInspection table had the following field(s) added:

 l DCVGInspectionDateTime  

The dbo.DCVGSurveyFolder has the following field(s) added:

 l FieldComputerSurveySettingsId  

The dbo.EmailReport table has the following fields added:

 l JobScheduleDefinitionId
 l Hierarchy
 l Mode

 l Name
 l SendNoDataFound
 l NextRunDateTime

The dbo.FieldComputerSurveySettings table had the following field(s) added:

 l DcvgBeginPsOn
 l DcvgBeginPsOff
 l DcvgEndPsOn

 l IsNativeSurvey
 l FieldComputerSerialNumber
 l DvmSerialNumber

 l DcvgEndPsOff
 l DcvgBeginHalfcellCalibration
 l DcvgEndHalfcellCalibration

 l DvmCalibrationDateTime
 l RefCellCalibrationDateTime
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The dbo.InLineInspection table had the following fields added:

 l ILInspectionAnomalyExtension
 l ILInspectionAnomalyTypeCL
 l ILInspectionAverageDepth
 l ILInspectionAxialOvality
 l ILInspectionB31GMAOP
 l ILInspectionBPRCalculated
 l ILInspectionBPRPig
 l ILInspectionBPRVariance
 l ILInspectionBurstPressure

 l ILInspectionInternalExternalCL
 l ILInspectionLengthAccuracy
 l ILInspectionMeasuredWallThickness
 l ILInspectionMiscIdentifier
 l ILInspectionMODB31GERF
 l ILInspectionMODB31GMOAP
 l ILInspectionOvality
 l ILInspectionRAWReferenceKey
 l ILInspectionRefEventIdentifier

 l ILInspectionCalibratedMeasure
 l ILInspectionCertaintyInterval
 l ILInspectionClusterIdentifier
 l ILInspectionComments
 l ILInspectionControlPointLF
 l ILInspectionCoordinateIdentifie

r
 l ILInspectionDataIdentifier
 l ILInspectionDepthAccuracy
 l ILInspectionDescription
 l ILInspectionDSAGMDistance
 l ILInspectionDSAGMReference
 l ILInspectionDSWeldDistance
 l ILInspectionDSWeldNumber
 l ILInspectionDSWeldOdometer
 l ILInspectionEventIdentifier
 l ILInspectionFeatureDescription
 l ILInspectionIdentifier
 l ILInspectionInspectionDate

 l ILInspectionRPRCalculated
 l ILInspectionRPRPig
 l ILInspectionRPRVariance
 l ILInspectionSeamOrientation
 l ILInspectionSMYS
 l ILInspectionStationReported
 l ILInspectionSurveyIdentifier
 l ILInspectionUSAGMDistance
 l ILInspectionUSAGMReference
 l ILInspectionUSWeldDistance
 l ILInspectionUSWeldNumber
 l ILInspectionUSWeldOdometer
 l ILInspectionWidth
 l ILInspectionWidthAccuracy
 l ILInspectionWithinSpecificationLF
 l InLineInspectionOriginalPoint
 l InLineInspectionOriginalPointAlph

a
 l InLineInspectionPlotThisPoint

The dbo.InLineSurveyFolder table had the following fields added:
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 l InLineInspectionIdentifier
 l InLineSamplingFrequency
 l InLineSurveyAvgTemp
 l InLineSurveyAvgVelocity

 l InLineSurveyRatedMaxVelocity
 l InLineSurveyRatedMaxWT
 l InLineSurveyResolution
 l InLineSurveySensorCL

 l InLineSurveyClusterRuleCL
 l InLineSurveyEndDate
 l InLineSurveyMaxTemp
 l InLineSurveyMaxVelocity
 l InLineSurveyMinTemp
 l InLineSurveyMinVelocity
 l InLineSurveyModel
 l InLineSurveyOdometerEnd
 l InLineSurveyOdometerStart
 l InLineSurveyPipeDiameter

 l InLineSurveySensorSpacingMax
 l InLineSurveySensorSpacingMin
 l InLineSurveySourceCL
 l InLineSurveyStartDate
 l InLineSurveyStatus
 l InLineSurveySurveyor
 l InLineSurveyToolType
 l InLineSurveyToolVendorCL
 l InLineVendorIdentifier

Fields Removed
The dbo.BridgeDefinition table had the following field removed:

 l CIInspectionDepthOfCover  

The dbo.EmailReport table has the following fields removed:

 l EmailReportDefinitionId  l OriginalReportId

The dbo.InLineSurveyFolder table had the following fields removed:

 l InspectionEndDateTime  l InspectionStartDateTime

The dbo.MetaParentAddition table had the following field  removed:

 l IsReplicated  

Fields Modified
The dbo.DCVGInspection table had the following fields' width changed:

 l IR from (5,2) to (5,3)

 l OTLtoRemoteEarth from (4,0) to (6,5)

 l SignalStrength from (5, 0) to (5, 4)

The dbo.FieldComputerSurveySettings table had the following fields' width changed:
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 l SecondsOff from (4, 3) to (5, 3)                   l SecondsOn from                   (4, 3) to (5, 3)

The dbo.Pipeline table had the following field's length modified:

 l PipelineEndPointAlpha from 15 to 50 nvarchar

Functions That Have Been Added to the PCS Database

 l dbo.MaxVal  l dbo.MinVal

New Stored Procedures in the PCS Database

 l dbo.recompile_prog  l dbo.RECREATE_TYPE

Stored Procedures that Have Been Removed from the PCS Database:

 l dbo.changeLogSynchronizationMaintenance

PCS 1.13 Updates

Major Enhancements

Image Management

New in PCS 1.13, the image management feature allows images to be attached to a record to provide a 
visual representation of the pipeline or facility, whether it is a schematic design, an identifying picture, or 
other graphic. The new image management capabilities allow you to add images to a record directly in PCS 
or attach images taken as part of a survey on the Allegro QX with the updated Allegro 7.0 software. Once 
pictures are attached to a record in PCS, they can be included in a form report (see Form Reports).

Form Reports

PCS 1.13 has introduced a report type familiar to PCS7, the form report. A form report designer was also 
added to enable advanced report customization. The form report allows for a closer examination of 
individual record’s information and can take advantage of the new image management feature by 
displaying a record’s images alongside the record’s data.
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Export to Table - Beta

PCS 1.13 includes a beta version of our upcoming export to table feature, which allows Bridge users to 
export PCS data, including calculated and derived fields, to a new Export database. The External definition 
type is configured in a similar manner as a Basic export. If you have any questions or need further 
assistance, give us a call at 1-800-229-3404 or email us at support@aiworldwide.com. 

Additional Databases

To support the new image management and export to table features, PCS 1.13 creates two additional 
databases. The images database contains all images that have been attached to a record in PCS. The 
export database contains the data exported by the beta export to table feature. The user who clicks  
Create/Upgrade in the PCS Connection Manager during the upgrade process must have permissions to 
create and modify a SQL database. Refer to Database Management in the PCS User Guide for additional 
information.

Milepost Location Formats

PCS 1.13 has improved the support of milepost location formats. The existing Location ID format has been 
upgraded to support up to 50 characters and the new Metric Milepost (6 Decimals) format allows for a 
precision of six decimals when recording milepost location. To use these formats, look for Location ID and 
Metric Milepost (6 Decimals) in the Default Location Format column in Edit ROW Detail. 

Improved Performance and Miscellaneous Updates

Several updates were made in PCS 1.13 to improve performance and reliability, including: 

 l Rectifiers Showing on the Graph — The PCS graph has been improved to reliably display rectifiers 
based on their Relative Milepost when the pipeline is configured to use Series.

 l Moving Inspections with Subfacilities — PCS now notifies you when you are trying to move an 
inspection that has subfacilities to a target that does not have subfacilities in the Data Modification 
Utility.

 l Reorder Sort Themes — PCS 1.13 has made it easier to reorder sort themes in a Field Computer 
prompt.

 l Increased Support of Calculated Fields in Filters — With 1.13, you can now filter between two dates 
using a Calculated User Defined Field that is of a DateTime2 data type.

 l Improved User Interface — When using a Windows 7 computer, the Windows title bar was 
shortened in some dialogs, resulting in a missing close button. This has been fixed in PCS 1.13.

 l Better Interactions with Bullhorn Engineering Units — The default Bullhorn - Bullhorn Engineering 
Unit values were changed for the following fields in Field and UDF Customizations:

mailto:support@aiworldwide.com?subject=AI Support
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 — Rectifier Inspection

 ¡ Rectifier Output Volts Found: the default value is now DC_VOLTS

 ¡ Rectifier Output Current Found: the default value is now DC_AMPS

 — Test Point Inspection:

 ¡ AC P/S: the default value is now AC P/S

 ¡ AC IRF: the default value is now AC IOX

These changes were made to match the default values in PCS with the values recommended in 
training.

 l Creation Date Field Available in the Subfacility Mini-grid — A new read-only field for a subfacility 
record’s creation date can now be added to the Subfacility mini-grid layout.

 l Filter Options Explained — The description of one of the included filters has been updated to more 
accurately explain what happens when the filter is chosen. The text has changed from “Only include 
facilities with inspections during the reporting period” to “Only Show Facilities with Inspections.”

 l Improved Notifications in Field Computer Receive — A notification was added during the Field 
Computer Receive process to alert users if a header file is missing when sending data from an Allegro 
field computer to PCS.

Changes to the PCS Databases

The following additions, modifications, and deletions are made to the databases during the PCS upgrade.

Databases new to 1.13

Refer to Additional Databases for more information:

 l [PCS database name]_Images

 l [PCS database name]_Export

Changes to existing tables in the PCS database:

 l In the Facility_Pipeline table

 — Facility_PipelineEndPointAlpha field increased in length from 15 to 50 characters

 — Facility_PipelinePointAlpha field increased in length from 15 to 50 characters
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 l In the Pipeline table: 

 — PipelinePointAlpha field increased in length from 15 to 50 characters

Tables that have been removed from the PCS database:

 l DynaFormsAddition

 l DynaFormsOverride

Tables that have been added to the PCS database:

 l AttachedImage

 l BridgeExternalDataItem

 l BridgeExternalMap

 l FormThemeAddition

 l FormThemeOverride

New stored procedures in the PCS database:

 l FreeWaistedProcCache

 l ReIndexFragmentatedIndexesPCS

New views in the PCS database:

 l AttachedimageCountsView

PCS 1.12.1 Updates

Known Issues

Reports that are formatted to use Landscape mode and sent via Email Notification will not format correctly 
when the job service is installed on a machine with Windows Server 2012 R2. Reports will format correctly 
when sent from a Windows Server 2008 R2 job service machine.

Fixed Issues

The following issues were discovered in 1.12 and were immediately fixed in 1.12.1:
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 l Survey Folder Maintenance — an extra day was added to the End Date for all survey frequencies.

 l Bridge Export — the wrong number of records was exported in an incremental Bridge export.

 l Telluric Graphs — selecting a point on the Chart Exclusions graph would no longer scroll to the 
associated record in the lower grid.

 l User Interface — when using a Windows 7 computer the Windows title bar was shortened, resulting 
in a missing close button. 

 l Scrolling in the Grid — when scrolling in a data grid there was a slight lag for those using Remote 
Desktop Connection to access PCS over a low bandwidth connection.

 l Email Notification — the Email Reports Detail log was showing the date and time of the first time the 
report was run rather than the actual run time of the selected email notification.

 l Field Computer — facilities were sent to the Allegro in the wrong sort order when selecting an 
exported list for the based on mode in Field Computer Send.

PCS 1.12 Updates

Upgrade Actions

Email Notifications and license management have undergone significant improvements in version 1.12 that 
may require additional actions before, during, and after upgrading PCS. If your company has email 
notifications set up, we recommend that you contact AI Support at support@aiworldwide.com prior to 
upgrading to ensure a smooth upgrade.

For details about changes to Email Notifications and license management, refer to Email Notification  and 
PCS License Management.

Get a New Product Key

When upgrading PCS from a version prior to 1.12, you will need to obtain a new product key. To get a new 
product key, purchase additional licenses, or change your licenses to the new concurrent or single seat 
models, contact AI Support.

IMPORTANT: All PCS computers with version 1.12 or later must have access to our Flexera license 
server.

Conform to Email Report Name Requirements 

When upgrading from versions of PCS prior to 1.12, a copy of the reports used in prior email notifications is 
made and given a unique name. To accommodate this, the reports used in prior email notifications must 
have names no longer than 42 characters. Review and update your report names manually or contact AI 

mailto:support@aiworldwide.com?subject=AI Support
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Support for a script that will identify all reports that have names longer than 42 characters and shorten the 
report names.

Prepare for Incremental Email Notification’s First Report

If you have Email Notifications set up with the Incremental mode set, the first report will be created as if it is 
the first time the report was run. This means that all unchanged, changed, and inserted data will be included 
in the report. 

It is recommended that you reset the report’s last run date after upgrading from PCS 1.11.1 and earlier to 
avoid creating a full report. 

Major Enhancements

System Requirements

PCS has been updated to support Windows 10, SQL Server 2014, Microsoft .NET 4.6.1, and Citrix 
XenDesktop Enterprise Edition 7.11. With this update, publication and subscription setups are only 
available with SQL Server 2014. Refer to the Installation or Upgrade documents for detailed System 
Requirements.

Email Notification

Email Notification was updated to improve email report management and delivery. The following features 
were introduced or upgraded:

 l On Demand Notifications — Email notifications now can be sent manually without modifying an 
existing schedule. 

 l Separation of Reports — The reports created for an email notification are no longer tied to reports 
created from the Reports/Graphs menu. Changes to a report in an email notification do not impact 
the original report it was based on.

 l Report Previews — You can now verify the ROWs that are included in an email report are the correct 
ROWs for a recipient prior to sending the email notification.

 l Test Emails — An option is now available to test the email settings, allowing you to verify that email 
notifications are able to be sent successfully before email notifications are created.

 l Report Generation Speed — By creating only one report when identical hierarchy and ROW 
selections exist and sharing the report among recipients, email reports’ generation is faster and frees 
up the Job Service queue for other tasks.
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PCS License Management

PCS has modified its license management to allow for both single seat and concurrent licenses. Single seat 
licenses allow for a specified number of users to have dedicated use of PCS. Concurrent licenses allow for 
any number of users to use PCS, but only a specified number of those users can use PCS at the same time.

When upgrading PCS from a version prior to 1.12, you will need to obtain a new product key. To get a new 
product key or purchase additional licenses, contact AI Support at support@aiworldwide.com.

All PCS computers with version 1.12 or later must have access to our license server.

Additional Logging for the Bridge Log 

With an added log to track Bridge rejections and warnings, it’s now easier to monitor Bridge successes and 
failures.

Improved Performance and Miscellaneous Updates

Several updates were made in PCS to improve performance and reliability, including:

 l Data Entry Grid — Various improvements and updates have been made to increase the speed and 
overall performance of the Grid.

 l Low Bandwidth Connections — By virtualizing your PCS experience with our support of PCS in a 
Citrix XenDesktop, you can now work in low bandwidth connections.

 l Field Computer Send — Field Computer Send prompts can now define whether the facility type is 
visible on the Allegro - providing control of valuable real estate on a small screen. Additional updates 
have improved the reliability of the status messages, logs, and other Field Computer functions. 

 l Bridge Preview — Files are no longer renamed for rejected Bridge Previews.

 l Leak Survey — The customer telephone number field has been extended to support up to 20 
characters.

 l Scheduling — Fields dependent on the Time Between Surveys field now have the same 
override behavior in the Hierarchy Level Override tab as in the Schedule Type Settings tab.

 l Data Modification Utility — The Data Modification Utility now ensures that when subfacilities of multi-
linked rectifiers are moved, the facilities are not duplicated.
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PCS 1.11.1 Updates

Email Notification Improvements

Enhancements were added to Email Notification to ensure that only the desired facilities are sent in an email 
report and that, when configured, email reports are successfully sent to multiple recipients.

Job Service Upgrades

Modifications were made to provide a more accurate representation of duration times for scheduled email 
reports, Bridge imports, and Bridge exports. PCS 1.11.1 also provides improved performance when 
sending email reports and importing data using Bridge.

New Features in Field Computer Send

The following options were added to PCS to complement new features in the Allegro MX version 5.3 and 
Allegro QX version 6.0 releases: 

 l Odd/Even Addresses in Sort Themes — A new option is available when creating a new Sort Theme 
that sorts even address numbers before odd address numbers. This new sort allows an Allegro user 
to complete surveys without having to cross the road after each site. Look for Address (Odd/Even) in 
the Fields pane.

 l Selectable Sorting Themes in Field Computer Send Prompts — Multiple sort themes can now be 
sent to the Allegro, allowing the Allegro user to change the sort order of the sites to one of the 
included sort themes while using the field computer. If Selectable Sorting Themes are not defined in 
the Field Computer Send prompt definition, the PCS user will only be able to select a single sort 
theme when sending data to the Allegro. For more information about Selectable Sorting Themes, 
refer to the Field Computer section of the PCS User Guide.

 l Searchable Fields in Field Computer Send Prompts — Field Computer Send prompt definitions now 
include Searchable Fields. Searchable Fields allow an Allegro user to search for a survey based on 
values in Searchable Fields while using the field computer. For more information about Searchable 
Fields, refer to the Field Computer section of the PCS User Guide.

PCS 1.11 Updates

Range Data

PCS now supports defining custom pipe segments based on a starting and ending milepost range in 
custom modules, regardless of the current series definitions. This new range data capability allow an 
administrator to create a custom module for visual inspections of an entire length of a pipe segment without 
tying an inspection to a specific location or facility. 
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Graphs Layout Editor

The new Graphs Layout editor introduced in version 1.11 allows you to create custom graph report layout 
themes, defining what fields are included in a graph and how many graph bands are displayed on a single 
page. Once created, these themes can be used to visualize and print PCS data. Refer to Working with 
Graph Report Layout Themes in Reports and Graphs from the PCS User Guide.

Bridge Preview

Version 1.11 introduces a Bridge Preview feature, in which data can be previewed before performing a 
Bridge import. Bridge Preview allows you to identify and resolve potential data problems before importing 
the data into PCS. Bridge Preview identifies and highlights the following types of data:

 l New — new data that, once the bridge transition file is imported, would be entered into PCS. 

 l Rejected — invalid data that, during the bridge transition file import, PCS would reject.

 l Redundant — data that matches data already in PCS or elsewhere within the bridge transition file 
and therefore will not be imported.

 l Warning — data that has warning messages.

 l Reformatted — data that, during the bridge transition file import, will be reformatted to conform to 
PCS standards.

After reviewing the data in Bridge Preview, you can choose to accept the data as is and continue with the 
Bridge import or choose to discard the data from the Bridge and modify the original data before attempting 
to import into PCS. Refer to Bridge from the PCS User Guide for more information.

Limited Subscriptions

A new feature available in version 1.11 for computers in a client/server network with support for replication 
is limited subscription. Limited subscription allows a subscriber to synchronize only a subset of data from 
the publisher. Enabling limited subscription can save database space on a client computer and save time 
when synchronizing by only synchronizing data that the client cares about. Clients can configure their 
subscription to synchronize data by making hierarchical selections in the Configure Subscription window. 
Refer to Synchronization from the PCS User Guide for more information.

Change History Improvements

Tracking data changes has improved in version 1.11. Viewing the data changes has become easier - the 
history of deleted items can now be accessed easily and reports of change history can be created and 
exported into Excel. Change History Reports can be created based on facility type, data type, date of 
change, and change type to support audits. The layout of these reports can be modified like any standard 
Columnar Report.
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In addition, tracking data changes using change data capture (CDC) is now available for computers in a 
client/server network with support for replication.

PCS 1.10 Updates

Change History

Changes to PCS data can now be tracked, recording who made the change, what tool was used to make 
the change, when the change was made, and what the data was before the change. With this information, 
data audits become more reliable and troubleshooting data abnormalities is made easier. 

It is recommended that change tracking configurations are made during the initial configuration of PCS or 
while performing system maintenance.

Forms Editor

The new Forms editor allows you to create custom form themes, placing data fields and mini-grids on a 
form theme alongside images, text labels, tabs, and borders. Once created, form themes can be used 
alongside or in place of the data entry grid to view and edit PCS data. 

Bridge Performance Updates

Changes were made to the way that Bridge processes data to optimize performance. As a result, there will 
be a noticeable increase in the speed of Bridge transactions.

Improvements were also made to the way PCS handles imports that include multi-linked facilities (for 
example, rectifiers) when the bridge mapping includes right of way (ROW) and milepost information. 
Previously, new ROW links were created for these imports. Now in version 1.10, the primary link in ROW 
links will be updated to become the value in the transition file for the facility key.

Optimizations for Smaller Screens

Improvements were made to the data entry grid and help screens to optimize PCS for smaller screens. 
Buttons are placed on the screen dynamically to accommodate different window sizes and scroll bars are 
added to window panes as needed when displayed on small or low resolution displays. In addition, the user 
help was redesigned to allow the table of contents to automatically collapse to the side or bottom of the 
window when viewed in a smaller window and to be resized manually. These improvements to the online 
help ensure the help topics’ content is more accessible and readable.

Improved Performance and Miscellaneous Updates

Several updates were made in PCS 1.13 to improve performance and reliability, including: 
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 l Rectifiers Showing on the Graph — The PCS graph has been improved to reliably display rectifiers 
based on their Relative Milepost when the pipeline is configured to use Series.

 l Moving Inspections with Subfacilities — PCS now notifies you when you are trying to move an 
inspection that has subfacilities to a target that does not have subfacilities in the Data Modification 
Utility.

 l Reorder Sort Themes — PCS 1.13 has made it easier to reorder sort themes in a Field Computer 
prompt.

 l Increased Support of Calculated Fields in Filters — With 1.13, you can now filter between two dates 
using a Calculated User Defined Field that is of a DateTime2 data type.

 l Improved User Interface — When using a Windows 7 computer, the Windows title bar was 
shortened in some dialogs, resulting in a missing close button. This has been fixed in PCS 1.13.

 l Better Interactions with Bullhorn Engineering Units — The default Bullhorn - Bullhorn Engineering 
Unit values were changed for the following fields in Field and UDF Customizations:

 — Rectifier Inspection

 ¡ Rectifier Output Volts Found: the default value is now DC_VOLTS

 ¡ Rectifier Output Current Found: the default value is now DC_AMPS

 — Test Point Inspection:

 ¡ AC P/S: the default value is now AC P/S

 ¡ AC IRF: the default value is now AC IOX

These changes were made to match the default values in PCS with the values recommended in 
training.

 l Creation Date Field Available in the Subfacility Mini-grid — A new read-only field for a subfacility 
record’s creation date can now be added to the Subfacility mini-grid layout.

 l Filter Options Explained — The description of one of the included filters has been updated to more 
accurately explain what happens when the filter is chosen. The text has changed from “Only include 
facilities with inspections during the reporting period” to “Only Show Facilities with Inspections.”

 l Improved Notifications in Field Computer Receive — A notification was added during the Field 
Computer Receive process to alert users if a header file is missing when sending data from an Allegro 
field computer to PCS.
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PCS 1.9 Updates

Data Modification Utility

The Data Modification Utility is a new feature that allows you to permanently move facilities and facility 
records, including subfacility, inspection, and maintenance records, from one facility to another facility. Use 
this feature when splitting or combining pipeline segments.

Import and Export Routes

Existing routes in PCS can now be exported to or imported from Excel or Comma Separated Values (CSV) 
files. Using the new import and export capabilities, routes can be exported to a file, modified in third party 
tools, and then re-imported into PCS, replacing the original exported route.

Security

Updates to user roles and their permissions in PCS were made to enhance the security options available in 
PCS. The enhancements have been made to Role Customization, allowing for a more granular 
configuration of a role's accessibility. These roles can be customized to the desired access levels and 
access to menu items and grid levels can be granted or restricted based on specific user roles.

New Fields

A new Repair Technician field is now available for customized layout or sort themes in the 
Maintenance grid in Edit CPDM Data. This field can be found under the Test Point Maintenance group.

Mini-grids Dialogs

Add Record dialogs similar to those found in the Facility Edit data grid were introduced to the following mini-
grids:

 l Test Point Detail Information

 l Rectifier Anode Information

 l Rectifier Negative Information

Based on Icons

Icons now appear throughout PCS to indicate which Based On mode is the currently active theme mode.

Shortcuts

New keyboard shortcuts are now available in the following locations:
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 l Using Data Entry Grids: The following keyboard shortcuts are available when adding a facility 
information, inspection, and maintenance record and when adding or deleting a record in a 
Continuous Survey:

 — Press F4 to add a history record with an effective date for currently selected grid record

 — Press F8 add record in grid

 l Working with Pipeline Records (Edit ROW Detail): The following keyboard shortcuts are available 
when adding a pipeline information record or adding a pipeline maintenance record

 — Press F4 or F8 to add a history record with an effective date

 l Working with a Continuous Survey Folder: The following keyboard shortcuts are available when 
adding a continuous survey folder:

 — Press F4 or F8 to add a record in survey folder maintenance

 l Using Any Date Field: The following keyboard shortcuts are available in any date field: 

 — Press T to fill in the current date and time

 — Press + or - to move the day forward or backward by one day

 l Using Any Numeric Field: The following keyboard shortcuts are available in any numeric field:

 — Press + or - to reverse the polarity and negate the current positive or negative value. 

Test Point Details Changes

CPDM Test Point Inspection Detail mini-grid fields that contain on/off behaviors now inherit the attribute 
values of the linked Inspection grid field. The inherited attribute values are based on the selected value of the 
mini-grid PCS Field field.

In addition, the following Test Point Detail fields have updated precision requirements:

 l TestPointDetailInspection.OnReading: Size: 10 Decimals: 5

 l TestPointDetailInspection.OffReading: Size: 10 Decimals: 5

 l TestPointDetailInspection.UncompensatedOnReading: Size: 10 Decimals: 5

 l TestPointDetailInspection.UncompensatedOffReading: Size: 10 Decimals: 5

 l TestPointDetailInspection.OnReadingDelta: Size: 10 Decimals: 5

 l TestPointDetailInspection.OffReadingDelta: Size: 10 Decimals: 5
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PCS 1.8 Updates

Telluric Compensation

Telluric Compensation is an optional feature set that provides support for compensating facility and close 
interval inspections with telluric current effects. Stationary data logger (SDL) files used in compensation 
runs are managed in Stationary Survey Maintenance. PCS features enhanced for Telluric Compensation 
include the CPDM and ISM modules, Bridge Import, Field Computer, and Reports/Graphs. 

Customers with an existing PCS license who want to use the optional Telluric Compensation feature will 
need a new PCS license. Contact PCS Technical Services for more information. 

System Options

 l Default Telluric Threshold: This option only displays when running PCS with a telluric-enabled 
license. The Default Telluric Threshold is in a range of 0.010 volts but can be changed to meet your 
business needs. PCS calculates a baseline average for survey measurements in an SDL data set. If 
any survey measurement in the data set is above or below the baseline average by 0.010 volts, this 
indicates the data set exhibits telluric current effects. 

 l Show Detail Inspection Entry Grid: This option controls the display of CPDM Test Point Detail mini-
grids. When using the optional Telluric Compensation feature, this option is enabled by default and 
cannot be disabled. 

CPDM Test Point Detail mini-grids

Information and Inspection mini-grids display by default when using the optional Telluric Compensation 
feature and cannot be disabled. 

IMPORTANT: To prevent adding duplicate subfacility records in the system, it is important to enter a 
unique subfacility name when adding multiple subfacility records for a test point record in the Test Point 
Information grid. Enter a unique subfacility name in the Name field of the Test Point Detail Information mini-
grid. Do not use the default name for this field or leave it empty (blank).

Job Service Viewer

 l Current Jobs: When a job is in a Waiting or Validated state, clicking the Suspended button suspends 
processing of the selected job. Other jobs in the queue continue to process. Clicking the Suspended 
button for a suspended job resumes processing. 

 l Job History / Detail Log: Option labeled ReSend in the Detail Log for an Email Notification report 
allows you to resend the report. 
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Field Computer

 l Dynamic Picklist User-Defined Fields (UDFs): Can now be included in prompts sent to the Allegro 
Field computer. 

 l Mini-grid Fields: ON/OFF subfacility fields in the Test Point Detail Inspection mini-grid can now be 
included in prompts sent to the Allegro Field Computer. The following criteria must first be met to 
include ON/OFF subfacilities in Allegro prompts:

 — Subfacilities must be set up as Currently Active in the Test Point Detail Information mini-
grid.

 — The parent facility of ON/OFF subfactilities must also be included in prompts sent to the 

Allegro. For example, parent facilities include any of the following PCS fields: AC P/S and AC 
IRF; Casing P/S and Casing IRF; Foreign P/S and Foreign IRF; Insulator 
P/S and Insulator IRF; or Structure P/S and Structure IRF. 

 l Field Computer Receive: Pipeline Series and ROW can be applied to close interval (CI) survey 
readings received from the Allegro Field Computer. 

Edit ISM Data / Survey Maintenance

Enhancements in Survey Maintenance allow you to select an existing facility when modifying a range of 
station numbers using Shift and Rubber Band. 

Field and UDF Customizations

Optional property setting labeled Show Time In Milliseconds allows you to set date/time fields with 
millisecond resolution. The property setting applies to date/time fields in Bridge, Field Computer, Reports, 
and data entry grids. 

PCS 1.7 Updates

System Requirements

Microsoft .NET Framework v4.5 is required for PCS v1.7. The PCS installation automatically installs .NET 
Framework v4.5 if it is not installed on the target computer. An active Internet connection is also required to 
complete the installation of .NET Framework v4.5. 

System Options

 l Date Carry Forward Enabled Option: Enabling this option allows you to use the last entered survey 
date as the survey date for the next record when working in an Inspection grid or form.
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 l Show Detail Inspection Entry Grid: Enable this option to display the CPDM Test Point Information and 
Inspection Detail mini-grids.  

Metric Measurements

The system option Activate Metric Mode has been replaced with setting metric measurements at the ROW 
level in Edit ROW Detail. The selection list for Default Location Format now includes the Metric Milepost 
option. This feature is typically used with a pipeline network that spans an area requiring both metric and 
U.S. Customary measurements. 

Negative Milepost Locations

PCS supports facility locations on a pipeline segment with negative milepost numbers. 

Long Name Support

The names of hierarchy folders as well as the fields labeled ROW Code and ROW Name support up to 100 
characters. Names longer than 100 characters are shortened by truncating characters to the right. 

The names of routes support up to 100 characters when adding a new route in Define Routes (Data Entry > 
Define Routes > Add). 

Pipeline Series

Enhancements in pipeline Series now calculate the relative milepost based on the previous Series. Series 
Order has been replaced with Previous Series to allow linking of multiple Series in a pipeline Series chain. 

Replication/Reinitializing a Subscription

Subscribers are no longer able to reinitialize a subscription database. This functionality is now available only 
with the publication database. 

CPDM Test Point Detail Mini-grids

Support for test points with multiple potential measurements is available using the Test Point Information 
Detail and Test Point Inspection Detail mini-grids. These mini-grids become available for use after enabling 
the system option Show Detail Inspection Entry Grid. The mini-grids function in a similar manner as the 
rectifier mini-grids when linking rectifier anodes and negatives. 

Dynamic Picklist User Defined Field (UDF)

Field and UDF Customizations now support set up of dynamic picklists. A dynamic picklist is a dynamic 
drop-down list with data items that change based on a data item selected in another picklist. This 
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dependency uses a cascading parent/child relationship. Selecting a data item in the drop-down list of 
picklist A (parent) determines which data items are available for selection in the drop-down list of picklist B 
(child). 

NOTE: Dynamic Picklist UDFs are not currently supported on the Allegro Field Computer. 

Custom Module Management (CMM)

PCS supports up to ten (10) user defined modules with each module supporting up to ten (10) user defined 
facility types. 

PCS 1.6 Updates

PCS Upgrade Installation 

 l The upgrade process now copies forward the existing connection settings file set up in Connection 
Manager when upgrading PCS to v1.6 and higher. Manually copying the file to the desktop prior to 
upgrading PCS is no longer required. 

 l The upgrade process for v1.5 to v1.6 and higher automatically uninstalls v1.5. Manually uninstalling 
v1.5 is no longer required. Upgrading a version previous to v1.5 does, however, require uninstalling 
the older version of PCS. 

Field and UDF Customizations

 l On/Off Pair UDF: Type of UDF that allows you to set up a custom pair of on/off fields for recording 
inspection readings in a data grid or form. This type of UDF is available for both facility and 
continuous surveys.    

 l Summation UDF:  Type of UDF that performs an aggregation on one or more fields set up as a filter in 
the Summation UDF. Aggregate functions include Average, Count, Latest, Maximum, Minimum, and 
Sum. This type of UDF is a Permanent Information field available for use in data grids, forms, reports, 
and as a filter in scheduling. 

Bridge

 l Prevalidate, Run, Import, Export: Clicking Prevalidate in the Bridge Definition window validates the 
Bridge definition is set up correctly. The validation process only validates data; it does not import or 
export data. Clicking Run, Import, or Export in the Bridge Definition window processes the definition 
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by importing or exporting data based on the setup of Bridge definition. 

 l Bridge Import: Check boxes are no longer enabled by default for all “Activate” fields in a Bridge 
import. 

Synchronization / Subscription

A message displays when starting a PCS subscription that identifies the last time the subscription 
synchronized with the publication database. 

CPDM Rectifier Data Grid

The following fields are no longer “read-only” and can be edited: shunt rating, resistance, factor, and 
rectifier rating.

 l Reindex Stored Procedure: A stored procedure labeled dbo.DefragmentIndexes installs in the 
PCS database during the v1.4.5 upgrade installation. The purpose of the stored procedure is to 
rebuild indexes in the PCS database that have exceeded the “fill factor limit”. To ensure optimum 
system performance, use the stored procedure to create a database maintenance job on the 
database server that runs daily or once a week during non-peak hours. 

PCS 1.5 Updates

PCS Axis Installation File 

The PCS Axis installation file has been updated to include the following features:

 l Separate installation files are no longer required to install PCS Axis on a 32-bit and 64-bit computer 
system. A single installation file now installs PCS Axis on either computer system. 

 l If the target computer does not have Microsoft .NET Framework v4.0 installed, the PCS Axis 
installation automatically installs it. This feature requires an active Internet connection to complete 
the installation of .NET Framework v4.0. 

Reindex Stored Procedure

A stored procedure labeled dbo.DefragmentIndexes installs in the PCS Axis database during the v1.5 
upgrade installation. The stored procedure is intended for your company’s Database Administrator (DBA). 
The DBA will use the stored procedure to create a database maintenance job on the database server that 
runs daily or once a week during non-peak hours. The purpose of the stored procedure is to ensure 
optimum system performance by rebuilding indexes in the PCS Axis database that have exceeded the “fill 
factor limit”. For more information, refer to document entitled PCS Axis v1.5 Upgrade Installation. 
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Fill Factor Reset Script (optional utility)

A process included in the stored procedure mentioned earlier sets the “fill factor limit” of the PCS Axis 
database on the server. The “fill factor limit” can however be changed if required. Included on the PCS Axis 
v1.5 installation DVD is an optional utility script intended for your company’s DBA. The DBA can use the 

utility script labeled Defrag Fill Factor Reset Post Deployment.SQL to set the “fill factor 
limit” of the PCS Axis database. 

Data Entry Forms 

PCS Axis supports data entry forms migrated from PCS 7.5 or higher. A forms editor will be available in a 
future software release that allows you to create and edit data entry forms. 

Custom Security Roles (Security Role Management)

A security role is a named set of permissions that determine user access to menus and menu commands in 
PCS Axis. Use the security roles installed with PCS Axis (SysAdmin, User, and Read Only) as a template to 
create custom security roles. Then modify a custom security role based on the requirements of your 
company. You can modify custom security roles to include permissions that grant or deny user access to 
one or more PCS Axis menus and menu commands. 

Bridge Import

Supports the following logical/boolean format variables: yes/no; true/false; and 0/1 (zero/one). 

Email Report Default Time (Email Notification)

When adding a new Email Report, you can either set up the report to use the default “Time” setting (which is 
based on the system Options property setting “Email Default Time”) or enter a different time. The “Time” 
setting determines when an email is sent with the Email Report as an attachment. 

Reports/Graphs

PCS Inspection Graph: Include facility survey and continuous survey data in the same graph. Use the graph 
report to easily compare survey data in one or more surveys with data from other surveys. 

Synchronization

Subscription and Bridge License Message: Activate the Bridge license on the publication database first, 
and then synchronize subscription databases with the publication database. This process activates Bridge 
for operation on subscription databases. A message displays in the Job Service Console to this effect when 
a subscription database needs to activate Bridge via synchronization with the publication database (Tools 
> Job Service Viewer). 
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Database Management

 l Database Integrity Check: In the unlikely event data becomes corrupted in the database, use 
Database Integrity Check to identify and resolve instances of data inconsistencies. The process 
performs an audit of the database searching for issues that may prevent PCS Axis from loading or 
performing basic functions. Its purpose is to clean up data issues that may cause problems for users, 
such as orphan records and invalid hierarchy nodes. (File > Database Integrity Check). 

 l Reindex Database: The PCS Axis database uses indexes to identify the position of each record in the 
database. As you add and delete records, PCS Axis modifies the appropriate index to reflect new 
record positions. The Reindex Database process restores database efficiency by updating indexes. 

IMPORTANT: Before running Reindex Database, it is recommended that you make a backup of the PCS 
Axis database using Microsoft SQL Server Management Studio (SSMS). For more information about 
SSMS, see the AI document entitled PCS Axis Database Backup and Restore. 

PCS Axis Help

 l Help Window: The Help window is independent of the PCS Axis application. Users can continue to 
work in PCS Axis while viewing a contextual help topic. Contextual help is available by clicking the 
help button in any PCS Axis window. 

 l New Help Features: Two versions of PCS Axis Help are available for use. Both contain the same 
information. The default version is used in the PCS Axis application when viewing contextual help 
topics. The alternate version includes support for the following new features and is available for use at 
http://www.pcsaxishelp.aiworldwide.com/AxisHelp/. 

 l Discussion System: Support for Disqus is available in the alternate version of PCS Axis Help. Disqus 
is a discussion system that allows users to post feedback, questions, or comments about PCS Axis. 
PCS Technical Services moderates the discussion system providing answers to questions and 
replies to comments. For more information about the discussion system, visit the Disqus website at 
http://help.disqus.com/. 

 l Language Translation: The alternate version of help supports language translation using Google 
Translate. To view PCS Axis Help in your language, click the globe icon in the menu bar and then 
select a language. Google Translate supports over 60 different languages. For more information 
about Google Translate, visit https://support.google.com/translate/. 

http://www.pcsaxishelp.aiworldwide.com/AxisHelp/
http://help.disqus.com/
https://support.google.com/translate/
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PCS 1.4.5 Updates

PCS System Performance Improvements 

PCS Axis v1.4.5 is intended to optimize system performance by reducing database index fragmentation. 
Index fragmentation may occur in the PCS Axis database after importing large amounts of data using 
Bridge Import, Bullhorn Bridge, or Field Computer. 

Enhancements described in the following list are intended for your company’s Database Administrator 
(DBA). These enhancements should be applied to the PCS Axis database on the server after upgrading to 
v1.4.5. For related information, refer to the document entitled PCS Axis v1.4.5 Upgrade Installation. 

 l Fill Factor Reset Script: A utility script labeled Defrag Fill Factor Reset Post 
Deployment.SQL is included on the PCS Axis v1.4.5 installation DVD. Running the script resets 
the “fill factor limit” on the database server to 70 percent. Run the utility script only once and do not 
include it in a database maintenance job on the server. 

 l Reindex Stored Procedure: A stored procedure labeled dbo.DefragmentIndexes installs in the 
PCS Axis database during the v1.4.5 upgrade installation. The purpose of the stored procedure is to 
rebuild indexes in the PCS Axis database that have exceeded the “fill factor limit”. To ensure 
optimum system performance, use the stored procedure to create a database maintenance job on 
the database server that runs daily or once a week during non-peak hours. 

PCS 1.4 Updates

Performance 

Improved performance system-wide with significant improvements in Bridge, Hierarchy Selection, and 
User Management performance.

User Interface

Improved user interface for better usability. 
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PCS Field Data Collector v1.3 Updates 

May 2021

Connection Manager 

Connection Manager is a utility that installs during the PCS Axis software installation. You can use 
Connection Manager to switch database connections; upgrade a PCS Axis database; and create a new 
database, such as a training database (Start > PCS Axis > Connection Manager). 

Job Service Viewer 

Job Service Viewer provides two functions. One allows you to activate the optional Bridge Import add-on 
while the other provides status information for the following PCS Axis jobs: Bridge Import, Bridge Export, 
Bridge Import/Export, Email Notification, and Field Computer Receive. Status information identifies which 
of these jobs are currently running; those that are waiting in the queue to run; and a history of completed 
jobs (Tools > Job Service Viewer). 

Pipeline Series

Pipeline Series is a feature that allows you to adjust facility numbers on a pipeline when discontinuities 
occur. Discontinuities can occur when an extension is added to the pipeline; the pipeline is re-routed; or 
when a company designates two pipelines as parallel lines. Instead of physically renumbering pipeline 
location numbers on-site, Pipeline Series allows you to shift pipeline numbering in PCS Axis. Each Pipeline 
Series joins together, end-to-end, to make up the entire pipeline. The starting and ending milepost for each 
segment in a Pipeline Series is used by PCS Axis to calculate a Relative Milepost for the entire distance of 
the pipeline (Data Entry > Pipeline Series). 

System Options

 l Disable Link Attachments: This system option applies when attaching a document to a record in a 
data grid. When the option is enabled, a document can be embedded but not linked to a record. A 
copy of an embedded document stores in the PCS Axis database and can be accessed by all PCS 
Axis users. A linked document stores on the local computer of the user who linked the document and 
can only be accessed by that user. If your company prefers that users embed documents instead of 
linking to documents, enable this option by clicking the check box. A check mark inside the check 
box indicates the option is enabled (Tools > Options > General).

 l Disable Synchronization: This system option allows you to disable the synchronization feature. When 
disabled, the Synchronization menu command is not included in the Tools menu, which prevents 
creating the publication and subscription databases. You can however activate Synchronization at 
anytime if your company decides later to use the feature (Tools > Options > Synchronization).
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 l Disable Attached Document Preview: This system option applies to documents that have previously 
been attached to a record in a data grid. When the option is enabled, users are unable to preview an 
attached document in the Preview Attached Documents window. When the option is disabled, users 
can open an attached document for editing or viewing purposes if the file type of the attached 
document is associated with a default software program on their computer (Tools > Options > 
General).

Synchronization / Server Authentication Mode

Creating the publisher and subscriber databases now requires that you identify the authentication mode 
used by the server to validate user names and passwords for users connecting to the server. Based on how 
your company has set up the server, the authentication mode is either Windows Authentication or Sql 
Server Authentication. If needed, contact your company's IT department to determine which authentication 
mode to select when creating the PCS Axis publisher and subscriber databases (Tools > Synchronization). 

Bridge Import

 l License Activation: If your company purchased the optional Bridge Import add-on, activate the 
feature for operation using Job Service Viewer to select the license file provided by American 
Innovations (Tools > Job Service Viewer).

 l Pipeline Series: Improvements in Bridge Import allow you to import pipeline series. Bridge Import 
includes a new data item labeled Series that is available for selection in the System Items folder when 
adding data items for mapping. Adding the Series data item provides the following PCS Axis fields 
required for mapping pipeline series: ROW Code, Series Number, Start Milepost, and End Milepost. 
These same fields must also be included in the import transition file you use to import data in PCS 
Axis.

Reports/Graphs

 l Data Collection Report: The data collection report is a blank report used by technicians and vendors 
to record survey readings in the field. It is available for selection in all modules except ISM. The report 
uses a columnar report style and includes survey information by module, such as the CPDM Data 
Collection Report. Based on the survey type selected when setting up the report, it includes a list of 
facilities and other optional data, such as previous survey readings (Reports/Graphs > Module 
Reports > Data Collection Report).

 l Summary Report Layout Theme: A layout theme is a group of named settings saved for later use. 
You can now define a Summary layout theme with report settings that define the table row, column, 
and data fields as well as the aggregate functions (average, sum, count, and percentage) used to 
calculate data fields in a Summary report. Summation fields, field operators, filters, drilldown fields, 
drilldown sorting fields, horizontal and vertical field groupings, as well as paper settings can all be 
saved in a Summary layout theme. A Summary report presents data in a cross tab table view. It 
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provides a “big picture” of pipeline and facility data by summarizing and analyzing the data. You can 
control how PCS Axis summarizes the data, for example by sum, average, count, or percentage. 
Using a Summary report can help with analyzing data, making comparisons, and detecting patterns 
in the pipeline system (Reports/Graphs > PCS, Module, or ROW Report > Customize > Summary 
Layouts).

PCS Field Data Collector v1.2 Updates 

April 2021

Synchronization (Tools menu)

PCS Axis Synchronization uses a Microsoft SQL Server publisher/subscriber database model. The 
Publication database is the primary database on a network server or host computer. Each Subscription 
database is a copy of the Publication database. Remote users who do not have access to the Publication 
database can update data in a Subscription database on their local computer. 

Synchronization supports one publisher with multiple subscribers running in a client-server network. 
Synchronizing data between the publisher and subscribers is achieved using merge/pull replication. Merge 
replication is used with the publisher database. Pull replication is used with subscriber databases.

Features of Synchronization include:

 l Creating the Publication database (primary PCS Axis database).

 l Setting up one or more subscribers (remote users).

 l Synchronizing and re-initializing a Subscription database. 

 l Switching database connections at a subscriber.
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PCS Field Data Collector v1.1 Updates 

March 2021

Indirect Survey Manager (ISM) 

ISM includes the following features for working with continuous survey data: 

 l Data Entry Grid and Themes 
(Data Entry > Edit ISM Data)

 l Survey Folders and Themes 
(Data Entry > Survey Folder Maintenance)

 l Reports, Graphs, and Themes 
(Reports/Graphs)

ISM reports and graphs include: CIS Reports (Close Interval Survey Reports); AC CIS Reports (AC 
Close Interval Survey Reports); DCVG Reports (DC Voltage Gradient Reports); ACVG Reports (AC 
Voltage Gradient Reports); ACCA Reports (AC Current Attenuation Reports); Soil Resistivity 
Reports; and Pearson Reports. 

 l User Defined Fields 
(Tools > Field and UDF Customizations > Continuous Surveys)

 l Field Computer and Themes 
(Field Computer > Send, Receive)

 l Themes Management 
(Tools > Themes Management; Tools > Facility Type Themes)

Custom Module Management (CMM)

CMM is an optional add-on available for purchase. CMM allows users to work with facility types not 
included with PCS Axis by creating a user defined module with up to six user defined facility types. CMM 
includes the following features:

 l Data Entry Grid and Themes 
(Data Entry > Edit <module> Data)
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 l Survey Folders and Themes 
(Data Entry > Survey Folder Maintenance)

 l Schedules, Routes, and Themes 
(Data Entry > Define Schedules, Edit Schedule Settings and Data Entry > Define Routes)

 l Reports, Graphs, and Themes 
(Reports/Graphs)

 l User Defined Fields 
(Tools > Field and UDF Customizations)

 l Themes Management 
(Tools > Themes Management and Tools > Facility Type Themes)

Email Notification

Email Notification is a feature for sending columnar reports as an attachment in an email at a regularly 
scheduled time to recipients. Recipients include PCS Axis users as well as non-PCS Axis users. 

Field Computer

Send and receive continuous survey data for use in the ISM module. 
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